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Retouch & Adjust 

In this lesson, we’re going to look at some of the retouching and adjustment chal-
lenges I ran into when working on this service station image. In the process, you will 
learn techniques for retouching your own images.

Here are the two challenges we’re going to tackle:

1. There is an undesirable sticker covering one 
of the gas pump toppers. We’re going to copy 
the clean top from the other pump and use 
that sampled content to cover the obstruct-
ed pump. The challenges will be making sure 
that the brightness and scaling match so that 
it blends in just right. 

2. The large Phillips 66 sign has a dark spot near 
the top and we’ll want to eliminate that. The 
challenge will be matching the color and tone 
of the dark shadow area to the surrounding 
colors on the sign. 

We’re going to learn 
some retouching and 
adjustment techniques 
that were used in the 
completion of this  
image.
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Retouch: Removing Sticker on Gas Pump (Timestamp 3:06)

We’re going to start by removing the stick-
er/label from the left gas pump. To do that, 
the top part of the pump will be copied 
from the right pump and then applied 
to the left one. We’ll activate the Healing 
Brush Tool. Any tool with the word “Heal-
ing” in the name is going to match the col-
or and brightness of the surrounding area, 
and this is what we’ll need in order to make 
the retouched part of the pump blend in 
with the part of the pump that surrounds it. 

After activating the Healing Brush Tool, click on the brush settings menu in the 
Options Bar above the image window. Here, make sure that the Hardness is set to 
100% to ensure that the tool has control all the way out to the edge of the brush. 

Before using the brush, we’re going to create a new, empty layer on which to place 
our retouch work. This will leave the original background image layer untouched. 
We’ll click on the New Layer icon at the bottom of the Layers Panel and the new 
layer will appear above the image layer. Make sure this layer remains active.

Whenever you use retouching tools on an empty 
layer, you’ll need to change a setting so that those 
tools will be allowed to work on an empty layer. 
With the retouching tool active, click on the Sam-
ple menu in the Options Bar and make sure it is 
set to “Current & Below.” This will allow the tool to 
use the content from that underlying image lay-
er and apply it to the empty retouch layer. With 
some retouching tools, this setting may be in the 
form of a “Sample All Layers” check box. In that 
case, make sure that it’s turned on. 

The Healing Brush is grouped with the Spot 
Healing Brush in the Toolbar. 

When applying retouching work 
to an empty layer, make sure the 
Sample menu is set to “Current & 
Below.”
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In the Options Bar, we’ll also make sure that the “Aligned” check box is turned on. 
This will cause the tool to remember the relationship between the sample area and 
the place where we initially click. As we move the brush around in the area we want 
to retouch, the sample area will move in unison. It will NOT reset its position each 
time we click to apply retouching. (Note: This is difficult to explain in words. In the 
lesson video, Ben shows what happens when this setting is NOT turned on and it 
will make it easier to understand. In general, though, keep this check box turned on 
and you’ll be good for this type of retouch work.) 

Using the Healing Brush To use the Healing Brush, hold down the Option key (Alt 
on Win) and click on the area you want to copy FROM. This will set the sample area. 
Then, release the Option key and click to paint on the area you want to retouch. 
As you hover the cursor over the image, you will see a preview of the sample area 
within the brush tip. This gives you a good idea of what you will be painting into the 
retouch area. You can change the size of the brush by using the brush settings in 
the Options Bar or by using the left and right bracket keys  ( [ ] ) on your keyboard. 

In the example image, we’ll hold down the Option 
key (Alt on Win) and click on the bottom point of 
the Phillips logo within the right-hand pump. This 
is a good sample area because the point serves as 
a good reference area when pasting to the other 
pump. We’ll move over to the left-hand pump and 
click the bottom point of the logo. This applies the 
sampled area to the retouch area. 

Now this might seem a little counter-intuitive, but 
we’re immediately going to undo that application by 
using the keyboard shortcut Command+Z (Ctrl+Z on 
Win). We just want that initial click to lock in the re-
lationship between the sample area and the retouch 
area. Now, the next time we click, it will remember 
that point and we don’t need to sample again. 

The Healing Brush is being used 
to sample an area from the  
unobstructed gas pump logo. 
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We’ll make the brush tip larger so that we can better see the preview of what’s go-
ing to be pasted. Immediately, we can see a problem. The bottom point of the logo 
does line up, but the circle that encases the logo does not line up. That’s because 
the pump we sampled from was closer to the camera and is therefore larger. If we 
move the cursor to the top of the pump, we can see that the alignment is off even 
more. To correct for this, we’re going to need to scale the retouching content. 

Clone Source Settings The settings in the Clone Source 
Panel can be used to manipulate the content that we 
sampled using the retouching tool. If it is not already 
open in your interface, you can access it by clicking on 
the Window menu and choosing Clone Source. 

In the Clone Source Panel, the W (width) and H 
(height) fields will allow you to scale the sampled con-
tent. That’s what we’re going to need to do in order to 
make the size of the logo match. If you look at those W 
and H fields, you’ll notice that there is a little link icon 
between them. That is telling you that the width and 
height will be locked proportionally. If you scale the 
content vertically, it will also be scaled horizontally. If 
that’s not what you need, then you can click that icon 
to unlink these two fields. 

As we hover the 
cursor over the 
retouch area, we 
can see a preview 
of the sample area 
that is going to be 
pasted. The bot-
tom tip of the logo 
lines up, but the 
circle surrounding 
the logo is NOT in 
alignment.

The settings in the Clone 
Source Panel allow you to 
manipulate the sampled  
content.
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We need to scale the content so that the logo that we sampled from the right-hand 
pump matches the size of the logo on the left-hand pump. When we scale the re-
touch content, it should scale from the point where we had originally clicked. This 
is the point at the bottom of the logo. 

There are keyboard shortcuts that 
allow you to more quickly change 
the clone source settings and we’ll 
use those here.  To scale the sam-
pled content, hold down Shift+Op-
tion (Shift+Alt on Win) and use the 
left and right bracket keys ( [ ] ). 

We will hover the brush tip over 
the top part of the pump (to better 
see the alignment) and use the left 
bracket key to make the sampled 
content smaller, tapping until the 
preview inside the brush tip match-
es the surrounding area. 

Once the top line matches, we’ll move the cursor around the circle that contains 
the logo so we can see how everything else aligns. Again, we see a problem. The 
top and bottom curves of the circle match nicely, but the left and right sides do 
not. This means that the sample area should not be scaled proportionally. We will 
need to click the link icon between the W and H fields in the Clone Source Panel 
to unlink the two fields. Now we can adjust the width independently of the height. 

Whenever we use the keyboard shortcuts, it’s going to scale the width and height 
proportionally. We don’t want that, so we’ll need to manually use the settings in 
the Clone Source Panel. We’ll click within the W field to highlight the text. Then, 
we’ll hover the cursor over the left side of the circle containing the logo. We’ll use 
the down arrow key to gradually lower the number until the line comes close to 
matching up. Then, we’ll move the cursor to the right side of the logo, doing the 
same thing. 

We are scaling the source content down so that it 
aligns with the retouch area. (The brush tip is  
highlighted so you can see it better.)
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We are unable to achieve perfect alignment on the left and right sides simultane-
ously, which means that we will need to use an additional setting: Offset. This will 
allow us to change the position of where the sample area is going to be pasted. 
The X and Y fields in the Clone Source Panel represent the offset, but we’re going 
to use another keyboard shortcut to change the setting. 

In order for this keyboard shortcut to work, we need to make sure that there are no 
fields currently highlighted in the panel. This would cause the shortcut to change 
the wrong setting. If there are any highlighted fields, we can simply click the Re-
turn/Enter key to lock in that setting so that the field is no longer active. Then, we 
can hold down Shift+Option (Shift+Alt on Win) and use the arrow keys to reposi-
tion the content. In this example, the circle containing the logo needs to be nudged 
to the left a bit. We’ll hover the cursor over the side of the circle so that we can see 
the preview inside the brush tip. Then we’ll hold down Shift+Option and then tap 
the left arrow key until the edge aligns. 

We clicked the link icon (circled) so that we can adjust the width independently from the 
height. You can see by looking at the brush tip that the left side of the circle aligns. 
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Up to this point, we have not yet even painted with the Healing Brush! We have 
just been setting up the clone source settings so that there is proper alignment 
when we DO paint. We’ll use a small brush so that we have a lot of control. We’ll 
start on the bottom tip of the logo, clicking and painting around the edge of the 
logo. As we do this, we need to be extremely careful that the brush does not touch 
the outer black outline of the circle. This could cause the Healing Brush to mess 
up, attempting to match the retouch area to something that’s black. We need to 
keep the brush contained within the white circle and the logo. After carefully going 
around the perimeter of the circle, we’ll paint over the interior. You’ll see that the 
content we’re pasting lines up perfectly and the logo from the right pump is suc-
cessfully used to cover the logo on the left pump. 

What’s nice about the settings in the Clone Source Panel is that you can switch be-
tween different retouching tools and the settings will remain the same. This means 
that you can use different tools, using the same alignment, to retouch the image. 

LEFT: We’re using the Healing Brush to carefully paint around the logo, making sure that we 
don’t hit the black outline. RIGHT: Without releasing the mouse button, we’re continuing that 
same stroke, covering the logo completely.
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Clone Source Panel Settings: The Basics

W & H: Scale the sampled content to make it larger or smaller. Keyboard 
shortcuts can be used by holding down Shift+Option (Shift+Alt on Win) 
and using the left and right bracket keys ( [ ] ). Use the left bracket to 
scale down and the right bracket to scale up. 

The Link icon: This icon is located between the W and H fields and it 
causes the content to be scaled proportionally. Click the icon to unlink 
the fields, allowing the width and height to be adjusted independently of 
one another. 

Offset: The Offset refers to the position of the sampled content. You can nudge 
the content left or right by changing the X field and you can nudge the con-
tent up and down by using the Y field. To use keyboard shortcuts, hold down 
Shift+Option (Shift+Alt on Win) and use the arrow keys to reposition the con-
tent. (Note: Make sure there are no fields highlighted in the Clone Source Panel as this will 
prevent the keyboard shortcut from working.)

Angle: The angle field allows you to change the rotation of the sampled con-
tent. To use keyboard shortcuts, hold down Shift+Option (Shift+Alt on Win) 
and then use the greater than, less than keys ( > < ).

After applying such specific settings in the Clone 
Source Panel, you have the option of saving those set-
tings in case you need to come back to the same re-
touch area. The icons at the top of the panel allow you 
to save clone source settings. By default, the left-most 
icon is highlighted, which means that the current set-
tings are being associated with that icon. If you were to click on the next icon, you’ll 
see the settings return to their defaults, ready to be manipulated for a different 
retouch area. If you wanted to return to the first retouch area, you could click on 
that first icon and it will have remembered all of the settings you had dialed in. You 
have the option of creating five different clone source setups. 

NOTE: If you ever see a warning symbol ( ! ) on top of one of the clone source icons, 
it means that the layer you were working on when creating that group of settings 
no longer exists. 

These icons allow you to save 
sets of Clone Source settings.
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Adjust: Fix the Dark Spot on the Sign (28:32)

Now let’s move on to adjust the large, Phillips 66 sign. There is a spot near the top 
of the sign that is darker and we want to lighten it so that it matches the rest of the 
sign.

Start with a selection The first thing we’re going to do is make a selection to isolate 
that area. We’ll use Quick Mask Mode to do that. In Quick Mask Mode, we can use 
the Brush Tool to paint in the selection. We’ll activate the Brush Tool and click on 
the brush settings icon in the Options Bar. This will expand a little panel of settings. 
Here, we’re going to adjust the Hardness slider so that the hardness of the brush 
matches the hardness of the dark spot. In this case, we set the Hardness to around 
80%. 

We’re going to correct the dark spot in the sign (circled). Before painting in Quick Mask 
Mode, we activated the Brush Tool and are setting the Hardness slider so that the hardness of 
the brush matches the hardness of the spot. 
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We’ll enter Quick Mask Mode by tapping the Q key on the keyboard. We’ll make 
sure that the foreground color is set to black. This is the color we’ll be painting with. 
When you paint with black while in Quick Mask Mode, you are adding a colored 
overlay, which will define the selection. By default, the color of the overlay is red, 
but you can change it by double-clicking on the Quick Mask icon, which is directly 
below the foreground/background swatches at the bottom of the Toolbar. 

We’ll use the brush to paint with black over the dark spot on the sign. This will cov-
er the dark spot with the overlay. In Quick Mask Mode, the area with the red overlay 
is the area that is NOT selected, so we’ll need to invert the selection by clicking on 
the Image menu and choosing Adjustments > Invert. Now the rest of the image has 
the red overlay but the dark spot does not. We’ll tap the Q key again to exit Quick 
Mask Mode and we’ll be left with a “marching ants” selection around the spot. 

Create a Curves Adjustment Layer Now that we have an active selection of the 
spot, we’ll create a Curves Adjustment Layer by clicking on the Adjustment Lay-
er icon at the bottom of the Layers Panel and choosing Curves from the pop-up 
menu. Because there was a selection active, that selection will by applied to the 
layer mask that is attached to the adjustment layer. The selection will become the 
white part of the mask, which represents the area of the layer that’s visible. 

LEFT: We painted with black over the spot while in Quick Mask Mode. This added the red 
overlay. CENTER: We inverted the mask so that the spot is the only area selected.  
RIGHT: We exited Quick Mask Mode and ended up with the “marching ants” selection.
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Now, we start by focusing on the orange “Phillips” text. We want the orange text 
that’s covered by the spot to match the orange text that looks good. We’ll activate 
the Targeted Adjustment Tool, which is the little hand icon on the left side of the 
Curves Properties Panel. In many cases, we could use this tool to click and drag 
up or down in the image, lightening or darkening that targeted tone. That doesn’t 
work in this case because the color needs to be shifting as well. We will need to 
use a technique that adjusts the points on the individual color curves (red, green 
and blue). 

Before setting the sample area, we’ll set 
the Sample Size menu (in the Options 
Bar) to “3 by 3 Average.” It’s set to Point 
Size by default, which will sample a single 
pixel. This can be a problem if there is any 
noise in the area. 

With the Targeted Adjustment Tool active, we’ll hold down the Shift and Command 
keys (Shift and Ctrl on Win) and we’ll click within the orange text that’s part of the 
dark spot. This will place a point on the individual red, green and blue curves. You 
can see these if you change the color menu above the curve chart to one of these 
colors. 

The Sample Size menu is being changed to 
3x3 average. That means that the Targeted 
Adjustment tool will take the average of a 
3x3-pixel area.

We sampled 
an area from 
the orange text 
and a point was 
placed on each 
of the three color 
curves.
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We’ll need to reposition these curve points in order to match the color to the sur-
rounding text. We’ll start with the red curve so we’ll choose “Red” from the color 
menu above the Curve chart. Below the chart, there are two numbers: Input and 
Output. When the cursor is not hovering above the image, those numbers define 
the value for the point on the curve. When the cursor is hovering over the image, 
those numbers define the red value for the area that the mouse is pointing to. 

We’ll hover the cursor over the part of the text that looks good and we’ll make note 
of the number that appears below the curve. We’ll enter that number into the Out-
put field beneath the red curve. This will adjust the point on the curve.  

We’ll then switch the color menu to Green and do the same thing, noting the green 
value when we hover over the ideal text and then entering that number into the 
Output field. Finally, we’ll do the same thing on the blue curve. 

ABOVE: We’re hovering the cursor over the 
part of the text that looks ideal, making note 
of the number values in the Curves dialog. 
RIGHT: We entered that number into the  
Output field and the curve point was  
repositioned.
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Looking at the result, the or-
ange text from the spot area now 
matches the surrounding orange 
text, but there are two issues: 1) 
Our initial selection was not spot 
on because you can see a dark 
outline around the spot. 2) The 
rest of the spot area shifted color 
in a way that does not look good.

Let’s refine the layer mask to elim-
inate the dark outline around the 
spot.  We’ll make sure that the 
layer mask is active and we’ll ac-
tivate the Brush Tool. We’ll use a 
small brush to paint with white 
over the dark outline that should 
be included with the selection. By 
painting with white, we are allow-
ing the adjustment to be visible in 
this area. 

The color problem lies in the fact that the part of the spot that used to be black 
now looks blue. We’ll correct this using the Blending sliders. With the Curves ad-
justment layer active, we’ll click on the FX icon at the bottom of the Layers Panel 
and choose Blending Options from the pop-up menu. The Layer Style dialog will 
appear and we want to focus on the “Blend If” sliders at the bottom of the dialog. 
We’ll use the “Underlying Layer” sliders. If we move the black slider to the right, 
we will be revealing the underlying layers in the dark parts of the layer. Therefore, 
the layer we’re currently working on can not affect the dark areas. We’ll move this 
slider to the right (while watching the effect on the sign) until the effect is removed 
from the dark spot. The transition will look abrupt, and we can fix that by splitting 
that little black slider in half. By moving the two halves independently, we will be 
controlling the transition. We’ll split the slider by holding down the Option key (Alt 

After the initial 
Curves adjust-
ment, there is 
a dark outline 
around the spot 
and the black 
part of the sign 
has turned blue.

We are using a soft brush to paint with white on the 
mask in order to expand the mask to eliminate the 
dark outline.
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on Win) and dragging one of the halves. With the slider split, we’ll drag the right 
slider just enough so that the transition becomes smooth but not so much that we 
start to lose the correction that was applied to the orange text. We’ll click OK to 
exit the Layer Style dialog. 

Now let’s create a second adjustment to further fix the dark spot. We fixed the text 
part of the spot, but the area surrounding the text is still too dark. We’ll click on 
the Select menu and choose Reselect. This will bring back that original selection 
that we made of the spot. (If this menu option is ever grayed out, you will need to 
manually recreate the selection.) 

With the selection active, we’ll click on the Adjustment Layer icon at the bottom 
of the Layers Panel and choose Curves from the pop-up menu. A second Curves 
adjustment layer will be created and, again, the active selection is applied to the 
layer’s mask. 

In the Blending Options of the Layer Style dialog, the black handle under the “Underlying 
Layer” slider is being used to remove the effect from the dark parts of the picture. You can 
see that the spot no longer looks blue.
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We’ll make sure that the Targeted Adjustment Tool is active and we’ll click and drag 
up on the dark spot. This will place a point on the curve and move it up, lightening 
that targeted area so that it matches the surrounding area. This does a nice job, but 
of course now the orange letters become too light. They had already been adjusted 
to look ideal. 

We’ll again use those blending sliders to correct the text. We’ll click on the FX icon 
at the bottom of the Layers Panel and choose Blending Options from the pop-up 
menu. The Layer Style dialog will appear and we’ll use the “Underlying Layer” slid-
ers near the bottom of the dialog. In this case, we want to make the bright areas 
go back to normal, so we’ll use the white handle on the right side of the slider. We’ll 
move this handle to the left until the orange text goes back to normal. Again, we’ll 
smooth the transition by holding down the Option key (Alt on Win) while dragging 
one half of the slider away from the other half. We’ll click OK to exit the Layer Style 
dialog. 

With the Curves adjustment active, the Targeted Adjustment Tool is being used to click and 
drag up on the dark part of the spot, lightening the area so that it better matches the sur-
rounding area.
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If any part of the effect looks too extreme, we can use the Brush Tool, set at a low 
opacity to paint on the mas

The white “Underlying Layer” slider is being used to hide the adjustment in the bright areas. 
This allows the orange text to go back to normal.


